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WIN-PAK 2.0 Release Notes

TD4228 ver. 0699

The information in this document supersedes any information in the WIN-PAK 2.0 User
Guide, Operator Quick Release Guide and Help.
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1 REGISTRATION

To register your copy of WIN-PAK 2.0 visit our web site at www.winpak2.com or print out
the registration form on this CD and FAX it to Northern Computers, Inc. at the number
listed on the form.

2 GUARD TOUR NOTE

The Guard Tour Server and Guard Tour functions are not available in the current release.
They will be available in a future release.

3 PANEL CONFIGURATION – OPTIONS NOTE

The User Guide section on Panel Configuration – Options tab (pages 160-162) indicates
that a command file can be selected in the panel defintion and sent to the panel during
initialization. This feature is not available in the current version of WIN-PAK 2.0.

Note that command files can be sent to the panel either manually or by the Scheduler.

4 WINDOWS 95/98 NOTE

In the Windows 95/98 operating system, if you log out of the Windows operating system
on the Database Server PC while the Database Server is running, and then log back in, you
temporarily invalidate the WIN-PAK 2.0 licensing. Performing a cold restart (power down
the PC and then turn it back on) allows you to restart your Database Server.

This problem is caused by Windows 95/98 faulty handling of multi-threading.

To prevent this problem, be sure to shut down the Database Server first, if it is necessary to
log out of the Windows operating system.  (This does not happen on Windows NT
systems.)

5 INSTALLATION – CAUTION! Norton Speed Disk Utility

The WIN-PAK 2.0 license files cannot be moved. The Norton Speed Disk utility program
moves system files by default, which disturbs the licensing files, causing loss of the
license. If you have installed the Norton Speed Disk defragmentation utility included in
Symantec’s Norton Utilities, you must modify certain settings to protect the integrity of
your WIN-PAK license files.

To solve this problem, open Speed Disk. On the File menu, choose Options->Customize,
and then select Unmovable Files.

Specify that the *.ent, *.key, and *.rst files cannot be moved.

Save the new profile by selecting Files->Options->Optimization->Save.

Speed Disk can now be run without affecting your license files.
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The WIN-PAK User Guide may refer a License Transfer utility. There is no License
Transfer Utility; the license files cannot be moved.

6 INSTALLATION - GENERAL

The installation program installs several utility and operating system upgrades during the
normal installation session. These are supplied as redistributable Microsoft packages and
are installed automatically based on the operating system and the installed options. The
installation program screens provide specific information during actual installation, but for
completeness, the information is also presented here.

Each of these components is installed by a separate installation program that runs directly
from the WIN-PAK 2.0 installation program. The installation program MAY REBOOT
AFTER EACH OF THESE COMPONENTS IS INSTALLED. The total number of reboots
required for any installation depends on which components are required.

If prompted by the program, always keep the latest drivers; never overwrite a new
driver with an old driver.

6.1 WINDOWS 98 NOTE

On Windows 98, some install segments can take up to 10 minutes to complete. This is due
to the nature of the installed components, and the need to reboot between component
installs. This delay may give the false impression that the install has been completed.
However, the INSTALLATION IS NOT COMPLETE UNTIL THE FINAL WIN-PAK 2.0
INSTALL SCREEN APPEARS. This screen is identified by a title bar, WIN-PAK 2 Set
Up Complete! The body text says, Click Finish to restart your computer and begin
using WIN-PAK 2.

The MDAC component must perform more installation related operations after the reboot
and this collides with the ongoing installation of WIN-PAK 2.0 components. There is no
known work around at this time, when the system is ready it will reboot and continue.

WIN-PAK 2.0 requires the following external components to be installed:

6.2 MDAC – Microsoft Data Access Components

Used for the DB server interface to the MDB file, and by the System Manager. Your
installation may require MDAC, or Microsoft Data Access Components be installed. While
this program upgrades all of your data access components, our main concern is the Access
ODBC drivers.

The MDAC components are considered part of the operating system, and therefore are
never removed, even when a full uninstall is performed.
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6.3 DAO – Data Access Components

Used by the system manager to compact and copy the database file. Installed when the
Database Server is installed. The installation will install version 3.5 of DAO.

Your WIN-PAK 2.0 installation may require Microsoft Data Access Objects to be installed.
The installation will be transparent, and the installation will determine if a reboot is
necessary.

INSTALLATION NOTE: These components are not considered part of the operating
system, and therefore could be accidentally uninstalled at a later date. If uninstalled, the
WIN-PAK 2.0 System Manager utility will not function properly and DAO 3.5 must be
reinstalled.

6.4 DCOM95 – Distributed Component Object Model

Used to update the drivers that shipped with Windows 95. The DCOM95 Driver Upgrade
component is installed for all Windows 95 systems.

The DCOM95 component is considered part of the operating system, and therefore is never
removed, even when a full uninstall is performed.

6.5 TAPI – Telephony Application Programming Interface

Used to update the drivers that shipped with Windows 95. The TAPI 2.1 Operating System
Extensions component is installed for all Windows 95 systems when the Communication
Server is installed.

The TAPI component is considered part of the operating system, and therefore is never
removed, even when a full uninstall is performed.

6.6 HHCTRL.OCX – HTML Help control

Used to access the help system on PCs with older versions of Internet Explorer. This
control is installed when the User Interface is installed. WIN-PAK 2.0 uses state of the art
online CHTML help. This online help system requires that several new components be
installed on your PC in order to function properly.  If the help system doesn’t function after
the install, you must install Internet Explorer 4.0 or greater.

WINDOWS 95 INSTALLATIONS: This new control may not work if you do not have
Microsoft Internet Explorer 4.0 or later installed on your system.

If you do not have Internet Explorer 4.0 or greater installed on your system, you should
consider upgrading. Even if you do not access the World Wide Web from this PC, there are
numerous upgrades in IE4.0 that you would benefit from.

Without IE4.0, your WIN-PAK 2.0 help system may be inoperative.
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6.7 Sentinel – The Sentinel Hardware Lock Drivers

These are installed on all operating systems when the Database Server is installed.

6.8 CrypKey – The CrypKey Licensing Drivers

These are installed on all operating systems when the Database Server is installed.

7 INSTALLATION TYPES

There are two types of installation: Full and User Interface Only. This differs from the
description in the User Guide.

7.1 Full

Select the Full installation when setting up a stand-alone system (an access control system
installed on one computer) or if you are installing the Database Server for a networked
system.

NOTE: On an NT system (not 95/98), only a user with NT administrator privileges can
connect to the Database Server. To allow other operators access, you must change a setting
in the System Manager.

1. Double-click the System Manager icon, and then select the User Interface tab.

2. Click Add. The Server Setup window appears.

3. Type a name of your choice for the Display Name. For the Database Server Node
Name type Localhost.

4. Click OK.

5. Click OK to close the System Manager.

7.2 User Interface Only

1. Select the User Interface Only installation when you are installing a workstation on a
networked system. Once the User Interface has been installed, open the System
Manager on the client PC.

2. Select the User Interface tab.

3. Click the Add button. The Server Setup window appears.

4. In the Display Name text box, type a descriptive name to identify the Database Server
in the list.
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5. In the Database Server Node Name text box, type the machine name of the Database
Server machine. (You can find the machine name from the Identification tab in the
Control Panel | Network applet.)

6. In the Database Archive Server Node Name text box, type the machine name of the
Database Server machine.

8 INSTALLATION PROCEDURE FOR NETWORKED SYSTEMS

Install the Database Server first using the Full installation option.

Install the User Interface Only for workstations. The UI can be installed from the CD at
each workstation or it can be installed across the LAN.

INSTALLATION NOTE: When installing over a LAN, make sure the install directory
resides on a drive that is shared and mapped in the target system. If this is not the case, the
install will fail when the system reboots and attempts to re-establish the connection to the
host directory.

8.1 Changing from a Full Install to a UI

If you perform a Full Install of WIN-PAK 2.0, and later decide to downgrade to a User
Interface only, you must first uninstall WIN-PAK 2.0 completely from the Control Panel |
Add->Remove Programs applet. BEFORE UNINSTALLING make sure you copy the
WINPAK2.MDB and the WINPAK2ARCHIVE.MDB files to the system you will be using
as the database server, as these files will be removed by the uninstall.

8.2 Changing from a UI to a Full Install

If you install a User Interface of WIN-PAK 2.0, and later decide to upgrade to a Full
install, you must first uninstall WIN-PAK 2.0 completely from the Control Panel |
Add->Remove Programs applet.

9 SETTING UP A NETWORK WIN-PAK 2.0 USER INTERFACE

9.1 Intro

This section is intended for advanced technicians interested in setting up distributed
networking solutions using WIN-PAK 2.0’s capabilities. The topics discussed will range
from PC architecture, TCP/IP, general networking, client/server architecture, and database
functionality. A certain level of knowledge in these areas is expected and implied.

9.1.1 Architecture

WIN-PAK 2.0 is a multi-part client-server application suite, existing in several modules
and connected via RPC and LPC.  This architecture allows extremely flexible
implementation, however, is far more complex than the monolithic applications of the past.
This document explains in detail how to implement a networked WIN-PAK 2.0 User
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Interface, and this knowledge can be applied to other client server relationships within the
WIN-PAK 2.0 suite.

The User Interface is a stand-alone application that communicates with the server
applications via LPC/RPC. Other servers communicate with the database server using
LPC/RPC as well.  The servers are full services in Windows NT and pseudo services in
Windows 95/98. No window is present in their normal operation. Debugging versions of
the services, which provide a console output window, are also shipped with WIN-PAK 2.0.
However, their use is reserved for error isolation applications. They should not be used in
everyday applications.

The UI and the database server store connection information in the system registry. This
information is not generally user accessible. However, Northern Computers has developed
an application that will provide a user interface to the connection information. This utility
is called the System Manager. The System Manager directs the UI to its database server,
and other servers located remotely.

9.1.2 Assumption Check

The assumption is that a Full install has been performed on a network workstation, and the
servers and user interface are properly operating on this system, and a second workstation
has a UI Install from the WIN-PAK 2.0 CD-ROM.  The server workstation will be called
“WP2PC” and the new workstation will be called “NEWUI.” The network names will be
the same.

9.2 Setup

9.2.1 Hardware

9.2.1.1.1 PC

The workstation platform has no additional requirements aside from the normal WIN-
PAK 2.0 system requirements.  A network card must be installed and operating normally.

9.2.1.1.2 NIC

Any standard Windows compatible network card can be used.

9.2.1.2 Software

9.2.1.2.1 OS

Windows 98 or Windows NT 4.0 Service Pack 4 (Workstation or Server) must be
installed and operating correctly.  TCP/IP must also be installed and working properly.

9.2.1.2.2 WIN-PAK 2.0
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The same version of WIN-PAK 2.0 that is running on the UI must also be installed on the
server machine.

9.2.1.3 Network

9.2.1.3.1 Machine Names

The machine name should be only alpha-numeric characters, and the first character
MUST be alpha only.

9.2.1.3.2 Network Access

The workstations need to be visible to each other. You should be able to ping both ways
(client -> server and vice-versa). Any firewalls, proxies, routers, etc. between the two
workstations could cause problems, unless a clear, unrestricted, permanent path can be
established.

9.3 Installation

9.3.1 Server

A full installation of WIN-PAK 2.0 must be performed on the server PC. Consult the
installation documentation before attempting this. No additional instructions must be
observed.

9.3.2 Client

The client should have been installed previously as a UI only install. Consult the
installation documentation before attempting this. No additional instructions must be
observed.

9.4 Connection

9.4.1 Server Workstation

1. After installation of WIN-PAK 2.0 on the server machine, run the System Manager.

2. Select the Database Server tab.

3. Write down the RPC endpoint. This is the same as a TCP/IP port address. It should be
5555. Do not change this number unless you have another service using TCP/IP port
address 5555.

4. Select the Database Archive Server tab.

5. Write down the RPC endpoint. This is the same thing as a TCP/IP port address.  It
should be 5556. Do not change this number unless you have another service using
TCP/IP port address 5556.
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6. Close the System Manager.

7. Get the machine name from the Identification tab in the Control Panel | Network
applet.

8. Close the Service Manager.

NOTE: In an NT system (not 95/98), only a user with NT administrator privileges can
connect to the database on the Database Server machine. To allow other operators access,
you must change a setting in the System Manager.

1. Double-click the System Manager icon, and then select the User Interface tab.

2. Click Add. The Server Setup window appears.

3. Type a name of your choice for the Display Name. For the Database Server Node Name type
Localhost.

4. Click OK.

5. Click OK to close the System Manager.

9.4.2 User Interface Workstation

7. If the user interface is running, exit it.

8. Run the System Manager on the client PC.

9. Select the User Interface tab.

10. Click the Add button

11. In the Display Name text box, type a descriptive name to identify the database server
in the list.

12. In the Database Server Node Name text box, type the machine name of the server
machine. (Ref. Step 7 from server machine ) If you wish, you can put in place of the
name, the IP address.

13. Verify that the RPC Endpoint is the same as the one you wrote down in step 3 of the
Server setup.

14. In the Database Archive Server Node Name text box, type the machine name of the
server machine. (Ref. Step 7 from server machine.) If you wish, you can put in place of
the name, the IP address.
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15. Verify the RPC Endpoint is the same as the one you wrote down in step 5 of the Server
setup.

16. Click OK.

17. Click OK.

At this point you’re ready to start up the UI with the new database server.

1. Run the WIN-PAK 2.0 User Interface.

2. Type in your login name and password.

3. Select the server from the drop down list in the Server Name area.

4. Click Connect.

5. Click OK.

9.4.3 Concurrent Connections

Now your system has the capability to have two concurrent User Interfaces. More can be
added until you reach the maximum specified by your licensing limit. You can verify your
client licenses in the User Interface by clicking Help | License. Contact your Northern
Computers Sales Representative for additional licenses. When you reach your licensing
limit on clients, you will not be able to open more on that database server.

EXAMPLE: If you have five client licenses, you can have five clients running
simultaneously.  If you open a sixth client, WIN-PAK will notify you that you have
exceeded your licensing and will not allow access to the database server. You can install
any number of clients, but you can only log five clients on to the database server at any
given time.

10 DATABASE MAINTENANCE FUNCTIONS

There are database maintenance functions available in the User Interface (Delete History
and Remove Deleted Records) and others available through the System Manager (Copy
Database and Compact Database). These functions are all aimed at maintaining data
integrity and optimal system operation. Regular database maintenance should be scheduled
by the system administrator.

The frequency of database maintenance depends on the size of your system and the number
of transactions taking place. A system with large amounts of activities may require much
more frequent maintenance. The Copy Database function can be performed while the
Database Server is in operation. This could be performed as often as once a day. The
Compact Database requires that the Database be shut down. It will probably be performed
less often than Copy, but at the very least, it should be done monthly.
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Copy Database (System Manager, Database tab) allows WN-PAK 2.0 to take a snapshot
of the database file while the database server is running. This copied database can be saved
to a tape drive or other media. The backup copy can be used to restore the database file (up
to the date of the most recent copy) in the event that the data becomes corrupted. The
backup database files also provide a source of report generation for information that is no
longer in the current database. The card holder photos and signatures, badge graphics, and
floor plan backgrounds are stored in separate directories. The database contains links to
these files, but making a backup copy of the database file does not make a copy of your
graphic files. To protect you data, you should make back-up copies of these files. You can
use any Windows-compatible utility to create copies of these files. If you have added
foreign language files, sound files or wallpaper graphics, be sure to make copies of these as
well. The default directory names are listed below.

BadgeImage - bitmap graphics used on badges

FloorPlanImage - floor plan background graphics

Language Files - text files for interface languages

Sound Files - sound files for use with action groups

UserImage - card holder photos and signature files

Wallpaper - wallpaper bitmaps

Compact the Database (System Manager, Database tab) reduces the size of the database
file, by removing unused information and empty space from the file. An un-compacted
database uses up disk space and also slows down the functioning of the system.

Database Restore If the active database file becomes damaged or corrupted, it can be
restored from the most recent Backup of Winpak2.mdb. Shut down the Database Server.
Then rename the corrupted database or save it to another directory. Then copy the Backup
of Winpak2.mdb into the WIN-PAK 2 database directory and rename it Winpak2.mdb.

Delete History (File menu, Database Maintenance) Periodically, it is necessary to
remove old history from the database file. How often this should be done and how much
history should be kept in the active database depends entirely on the requirements of your
system. Use this utility to remove history up to a selected date. (You cannot delete history
for the current date.) Remember that ONCE HISTORY HAS BEEN DELETED IT
CANNOT BE RESTORED except by restoring the entire database from a backup copy.
Also, reports cannot be run from history that has been deleted, except by using a backup
copy of the database. Therefore, it is usually a good idea to make a backup copy of the
database before deleting history.

Remove Deleted Records When records are deleted from a database, they are no longer
available in that database. But they have not actually been removed from the database file.
They appear in history and continue to take up space in the database. (For example, if a
card holder is deleted from the Card Holder database, his name does not appear on the list
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of all card holders. However, his name may appear in a history report.)  Use the Remove
Deleted Records utility to remove deleted records, thus reducing the size of your database.
Note that once you have removed the deleted records, they no longer appear in the
databases or reports. For example, if you delete a card holder, then remove deleted records,
a history report may show card activity for a card issued to the former card holder with a
date and time stamp, but the card holder name appears as a blank.

10.1 Typical Database Maintenance

The times given here are only examples. Your system requirements determine how often
these functions should be performed.

Copy Database – A copy of the database file is made daily using the Copy Database
utility. By default the copy is named Backup of Winpak2.mdb. The administrator selects
the folder where this copy is stored. A copy of this file is made and stored to the backup
media (tape). (A separate file folder should be created for each copy date and then that
copy should be saved to that folder. This is done so that the Backup of Winpak2.mdb is
not overwritten). Each tape is dated and stored.

As consecutive copies are saved to the backup media, the administrator can use an
identification and storage system of his or her choice. This is important because when
reports need to be run from Archive Database information, the backup copies from the
desired dates need to be retrieved.

Delete History – Monthly, following the creation of a new database backup copy, history
for the preceding month is deleted from the database. For example on May 31, history is
deleted up to May 1, leaving one month of history in the active database. At the same time,
the backup copy containing history from April 1 through April 30 is copied to the Archive
folder and renamed WinPak2Archive.mdb, thus making history for April available for
reports.

Remove Deleted Records – Monthly, after making a backup copy of the database, deleted
records are removed. These records are no longer available for reports unless the report is
run from Archive Database.

Compact the Database – Monthly, the Database Server is shut down and the Compact
Database utility is run. This removes unnecessary information and unused space from the
file. It reduces the size of the file and allows the Database Server to access the information
more efficiently.

11 DATABASE ARCHIVE SERVER

The Database Archive Server is located in the System Manager. It points to the location of
the WIN-PAK Archive Database (by default it is WinPak2\Archive\WinPak2Archive.mdb)
so that reports can be generated from information that is no longer in the active database.
The desired Archive Database must be copied manually to the Archive folder and named
WinPak2Archive.mdb.
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12 PROGRAMMING ORDER FOR WIN-PAK 2.0

 (For those who do not wish to read the manual)

Italicized are optional

Configuration Menu

Card Holder - Note Field Templates – Create note field names.

Card Holder - Card Holder Tab Layout – Create card holder tabs.

System Menu

System Defaults – Select Global ADV Access and Clear on normal only.

Workstation Defaults- Apply card number length, card deletion prompts, sound options,
wallpaper, language and sound file locations and alarm printer settings.

Configuration Menu

Card Holder - Configure Autocard Lookup –Select which note fields are displayed when
the AutoCard view is used.

Badge - Badge DLL’s – Setup the badging option (add capture card, and signature pad
DLLs).

Badge - Configure Badge Printer – General configuration.

Badge - Badge Layout Utility  – Enter badge layout names, design badge layouts.

Time Management - Time Zone – Create time zone elements.

Time Management - Holiday Group – Create groups of holidays that can be applied to a
panel.

Device - Device Map – Add communication server and ADVs in the server; add scheduler,
command and tracking servers.

Device - Device Map – Communication Server – Add panel loop, modem pools, CCTV
loops (including camera & monitor listings).

Device - Device Map – Communication Server – Panel Loop – Add New N-1000 Panel –
Make sure to add ADVs to the panel, inputs, outputs, groups, readers, doors. Without an
ADV, you may not be able to select a device in other sections.

Command File – Create command files by selecting from device specific lists of available
commands. Add the command files to panels..
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Define - Control Areas – Define a logical tree and grouping of selected devices. Used in
alarm, event and autocard lookup views.  The Control Areas define a Control Map which
provides an alternate control for the system.

Floor Plan Definition – Select a floor plan background, add ADVs (panels, doors, readers,
inputs ) associate them with devices and set control properties. You cannot control a device
if no ADV is assigned.

System Menu

Operator Level – Add operator rights (view, operate, none), to devices in the control tree,
databases and user interfaces.

Operator – Assign individual operators, passwords time zone and operator type.

Configuration Menu

Define - Access Areas – Define access areas on a logical tree, grouping entrances by
geographic location.

Card Menu

Access Level – Use access areas to select entrances and time zones.

Configuration Menu

Define - Tracking Areas – Define a logical tree grouping entrances or readers, forming
tracking areas and muster readers.

Card Menu

Bulk Card Add – Add a range of cards with a specific access level and
activation/expiration dates.

Card – Add a card, set its access level, activation/expiration dates, badge layout and card
holder if information is already programmed in.

Card Holder – Add card holders. Assign cards to card holders. Fill in note fields with card
holder information. Capture photos, signatures and assign badge layouts. Print badges.
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13 DATABASE CONVERSION FROM WIN-PAK 1 TO WIN-PAK 2.0

13.1 Introduction

The WIN-PAK 1 to WIN-PAK 2.0 database conversion utility program (DBConvert) is
used to port and convert a WIN-PAK 1 installation over to a new WIN-PAK 2.0
installation. The DBConvert installation is provided to customers along with the WIN-PAK
2.0 installation.

The current release of DBConvert converts three areas of WIN-PAK 1 over to WIN-PAK
2.0:

• Access Level Names

• Card Holders

• Cards

The Access Level fields are re-created by name only in WIN-PAK 2.0.  The access level
properties are not carried forward and must be re-created by the installer.

The Card Holder fields converted are:

• First Name, Last Name

• Note fields (25)

• Related image files (Pictures and Signatures)

Card Holder field names are NOT converted.

The Card fields converted are:

• Card Number

• PIN number

• Activation and Expiration (Deactivation) Dates

• Access Level

• Card Holder (Owner)

• Card Status

The User Priority (valid and invalid read priorities)

Card fields NOT converted are:
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• Backdrop associated names

• Uses left

• Action messages

• Command files.

13.2 Setup

Install WIN-PAK 2.0 and run the User Interface with a successful connection (log in), at
least once, before installing DBConvert. Install DBConvert on the same machine as the
WIN-PAK 2.0 database server.

After exiting the user interface and before running DBConvert, click the WIN-PAK 2.0
Services ICON and stop all WIN-PAK 2.0 services. This assures DBConvert sole access to
the WIN-PAK 2.0 database during conversion.

13.3 File Preparation

The next step is to prepare the WIN-PAK 1 files before conversion. Run WIN-PAK 1. In
the Rebuild function, select Access Level and Cards from the Database Table, and then
perform Pack and Reindex.

13.4  File Access

The next step is to decide how DBConvert accesses the WIN-PAK 1 data. The DBConvert
installation prompts you for the location of the WIN-PAK 1 database. When DBConvert is
run, it attempts to connect to the database in this directory. Likewise, the DBConvert
installation prompts you for the location of the WIN-PAK 1 image files (photos and
signatures). When DBConvert is running, it looks for card holder image files in this
directory.

13.4.1 WIN-PAK 1 Accessible From the Network

If WIN-PAK 1 database and image directories are accessible from the network and a
network drive is mapped to the location, enter this path during installation and DBConvert
will read the files over the network.

13.4.2 WIN-PAK 1 is Stand Alone

If WIN-PAK 1 is not accessible from the network, the database and the image files must be
copied to a directory on the WIN-PAK 2.0 machine.

The required database files are:

• PKALMAIN.DBF and PKALMAIN.MDX
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• PKCDMAIN.DBF and PKCDMAIN.MDX

• PKCDNTLK.DBF and PKCDNTLK.MDX

The required image files are all the *.jpg and *.sig files.

These local directory locations can then be entered during DBConvert installation.

13.5 Installation

Installation of this utility is performed from the WIN-PAK 2.0 installation CD. To begin
installation, click the WIN-PAK 1 to WIN-PAK 2.0 Conversion Utility button from the
autorun CD browser.

1. Click Next from the first dialog.

2. If you accept the license agreement, click Yes.

3. Click Next from the next dialog.

4. Enter your name and company name and select Next.

5. Choose an installation directory or use the default directory, then click Next.

6. Choose a Program Folder name or use the default, then click Next.

7. Enter the location of the WIN-PAK 1 database directory as discussed above. (You can
use the browse button to find it or type it in.) Then click Next.

8. Enter the location of the WIN-PAK 1 images directory as discussed above. (You can use
the browse button to find it or type it in.) Then click Next.

9. Installation will copy files to the install directory.

10. Click Finish to complete setup.

13.6 Running DBConvert

DBConvert is now ready to run. The DBConvert program is in the Start->Programs list.

When starting DBConvert for the first time, the following message may occur on some
systems:

“Couldn’t find installable ISAM.” If this happens click OK. Then click OK again on the
file dialog and the program should continue. If not, try running it again and it should be ok.
The system uses the default driver if the driver entry does not exist in the registry.
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Also, there may be installations that require a password to connect to the database. If the
program asks for a password, the default password is PAK.

The first thing DBConvert does is count the records it finds in the WIN-PAK 1 installation.
These are displayed in the top (WIN-PAK 1) part of the dialog. To start the conversion,
select the account into which to port the WIN-PAK 1 data. The To Account drop down list
box is in the dialog’s bottom right corner. Next, click the Convert All button. A progress
bar appears. The access level names are converted, then the cards and card holders.  For
large databases (e.g. 2000 entries) this could take several hours. The progress bar indicates
the conversion status. When the conversion is finished, the progress bar disappears and the
bottom (WIN-PAK 2.0) part of the dialog will display the total number of Access Level
Names, Cards, and Card Holders that have been converted. If these numbers are smaller
than the original WIN-PAK 1 counts, verify the actual WIN-PAK 1 record counts from the
WIN-PAK 1 user interface. Some deleted records may have been counted. If you cancel for
any reason, it is safe to restart the conversion. If DBConvert finds entries already in the
WIN-PAK 2.0 database, it does not enter them twice.

When DBConvert is finished, you can exit by clicking Exit. Then, select the WIN-PAK 2.0
Services ICON and start all the services.  After, connecting the to the WIN-PAK 2.0
database, you should find all the Access Levels, Cards, and Card Holders (including photos
and signatures).  However, one more step needs to be taken in order to see the note fields.

13.6.1 Creating Note Fields and Card Holder Tab

To get the note fields to appear in the card holders view, you need to define the note fields
and note tab for the view.  Since there are 25 WIN-PAK 1 note fields, define at least 25 in
WIN-PAK 2.0.

To define card holder note fields

1. On the Configuration menu, point to Card Holder and then click Note Fields
Template.

2. Click Add, enter a Note Field name, and click OK.

3. Repeat this for 25 note fields. You can be generic in your naming scheme and later edit
the names for the note fields or you can name them to match the note fields you were
using in WIN-PAK 1. If you are unsure of the names used, refer to the Winpak1.ini file
(located in the Windows directory of your WIN-PAK 1 computer) in the Note Fields
section.

Now go to the menu item: Configuration->Card Holder->Card Holder Tab Layout. Click
Add and enter the new tab name (e.g. Notes). Select all the Note Fields from the available
list and click Add. This will include the Note Fields in the new Notes tab. Click OK and
exit the card holder tab layout.
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When you go to the Card Holders view, you should see the Notes Tab. The Notes for a
Card Holder should match those in the WIN-PAK 1 database.

At this point, the conversion should be complete. You can remove the DBConvert program
using the Control Panel->Add/Remove programs feature.

14 DATABASE CONVERSION UTILITY FOR WIN-PAK 2.0 BETA TO WIN-PAK 2.0
RELEASE

14.1 Introduction

This utility was designed to upgrade/update the MS Access database of a beta or older
release version of WIN-PAK 2.0 to the newest release version of WIN-PAK 2.0.  The
utility will dynamically update any source WIN-PAK 2.0 database version to any
destination version.

14.2 Setup

Installation of this utility should be performed after the most recent release of WIN-PAK
2.0 is installed in its entirety. When installing an upgrade to WIN-PAK 2.0, select
“Manually Upgrade Database” when prompted by the WIN-PAK 2.0 installation
application. This option makes a backup copy of your existing database and creates a new,
empty database in the same directory. Your old database will be renamed to
WINPAK2.MDB.OLD.

CAUTION: If you select “Overwrite Existing Database” in the WIN-PAK 2 installation
application, all of your existing data (cards, card holders, access levels, floor plans, etc)
will be lost.

14.3 Installation

Installation of this utility is performed from the WIN-PAK 2.0 installation CD. A button
selection from the autorun CD browser will begin installation of this utility. Select
“Complete Install” when prompted.

1. Select Continue from the first dialog.

2. Select OK to install the utility to the “C:\Program Files\WIN-PAK 2 Database
Utilities” directory.

3. Select the Typical installation option.

4. The installation will commence at this point.

5. Select OK to end the install when the setup is done.

6. The utility is now resident on your PC.
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14.4 Upgrade Procedure

Once WIN-PAK 2 and the Upgrade Utility are installed, you can begin the upgrade
procedure.

CAUTION! Make a backup copy of your database BEFORE attempting to run this
application!  You should copy the “C:\Program
Files\WinPak2\Database\WinPak2.mdb.old” or “C:\Program
Files\WinPak2\WinPak2.mdb” file into a temporary directory.  While this utility has been
thoroughly tested, accidents happen, and if one does, you could loose your entire database.

1. If you’re running WIN-PAK 2, please log out of the User Interface and exit the
application. From the WIN-PAK 2 Service Manager application, select all servers and
click Stop.  Wait until all servers have stopped.

2. Backup your existing database.

3. In Explorer, navigate to “C:\Program Files\WIN-PAK 2 Database Utilities”

4. Run “WIN-PAK 2 Util.mde”

5. The utilities dialog will have 3 options, Compact Database, Convert db 2.0b to db 2.0,
and Exit this application. Select Convert db 2.0b to db 2.0.

6. You will be prompted to select your from and to databases.

7. On the db From line, click the Browse button.

8. Navigate to the “C:\Program Files\WinPak2\Database” directory and select the
WinPak2.mdb.old.mdb file as the db From. NOTE: depending on your BETA release,
this may be in the “C:\Program Files\WinPak2” directory and if it is it will be named
WinPak2.mdb. Click the Open button.

9. On the db To line click the Browse button.

10. Navigate to the “C:\Program Files\WinPak2\Database” directory and select the
WinPak2.mdb file as the db To. Click the Open button.

If you choose to convert history, you could wait a LONG time before the application
finishes. It is recommended that you DO NOT convert history unless it is absolutely
necessary to maintain old history. To skip converting history, select the “Do not Convert
History” checkbox.

1. At this point you’re ready to begin database conversion. Click Start to begin.

2. Depending on the size of your database, the speed of your PC and the speed of your
hard drive, this process could take anywhere from few minutes to a few days. When
done, click Close.
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3. Click Exit this Application.

At this point you’re ready to begin using your updated database. From the WIN-PAK 2.0
Service Manager, start your applicable servers and you’re ready to begin using your new
WIN-PAK 2.0 application.

15 KNOWN PROBLEMS

The following are known problems with the current release of WIN-PAK 2.0. They are
generally minor and should not adversely affect the operation of the software or the
integrity of your access control system.

LANGUAGE

No problems to announce.

SYSTEM EVENTS

No problems to announce.

EVENTS

No problems to announce.

ALARM VIEW

Operator Notes added to transactions are not wrapping in a text edit box. Therefore, the
operator must add carriage returns at the appropriate places by holding down the CTRL
key and pressing ENTER.

AUTOCARD LOOKUP

No problems to announce.

LIVE MONITOR

Live Monitor Freeze is not working. A right-click on the Live Monitor displays options for
“Freeze” and “Save.” They will be enabled in a future release.

FLOOR PLANS

No problems to announce. Floor plans identify shunted input points. When shunted, the
input point ADV is marked with a slashed circle. This is not documented in the User
Guide.

FLOOR PLAN DEFINITIONS

No problems to announce.

CONTROL MAP
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Input points that are in a shunted state are not indicated on the Control Map at this time.
Floor plans do identify shunted input points by marking them with a slashed circle.

GUARD TOUR (DATABASE / FUNCTIONALITY)

The Guard Tour Server is not functional so the Tours cannot be launched.

TRACKING AND MUSTERING (DATABASE / FUNCTIONALITY)

When the Muster server is restarted any cards being returned from history are getting a "not
ready" description in the readers column. This information does not affect the operation or
the accuracy of the tracking event. All other information is correct.

CARD (DATABASE)

Bulk Card printing from the list view only allows you to select those cards that are visible
in the database list. The higher the resolution the more cards available. Example: 1024 x
768 allows more cards to be seen when the card list box is stretched.

CARD HOLDER (DATABASE)

If multiple cards are deleted the list does not always refresh. Click the Select button to
refresh the list.

ACCESS LEVEL (DATABASE)

No problems to announce.

BULK CARD ADD

No problems to announce.

BULK CARD DELETE

The close (x) button doesn’t shut the Bulk Card Delete window. The Close button does
work.

OPERATOR (DATABASE)

No problems to announce.

OPERATOR LEVEL (TREE)

No problems to announce.

WORKSTATION DEFAULTS (CONFIGURATION)

1. Sound File Enable or Disable doesn’t take affect until the User Interface is restarted.
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2. Window Position and Size doesn’t save if the User Interface is closed before closing
each window individually.

SYSTEM DEFAULTS (CONFIGURATION)

REPORTS

SPECIFIC SECTIONS

1. Panel Reports can give you extra pages, two for every one.

2. History Reports using “Sequence ID” sort, grouping correctly but not correct in order
of receiving.

3. Panel Report doesn’t show outputs 17-32 in any group(s) they might have been
assigned to.

ACCESS AREAS (TREE)

No problems to announce.

TRACKING AREAS (TREE)

No problems to announce.

CONTROL AREAS (TREE)

No problems to announce.

DEVICE MAP

1. Panel configuration: If you have a panel with groups and anti-passback and you disable
anti-passback, outputs 17-32 become disabled.

2. Time and Date information is sent to Not Present panels on remote loops. This is not
detrimental.

3. CCTV: Changing the name of a camera ADV does not update the live monitor view
until it has been closed and then reopened.

ABSTRACT DEVICE (DATABASE)
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ACTION GROUPS

Printing select or deselect feature not functional. If alarm printing is required, all alarms
will go to the printer.

TIMEZONE (DATABASE)

No problems to announce.

SCHEDULES (DATABASE/FUNCTIONALITY)

Changes in Schedule names are not always displayed after they have been edited. Clicking
the Select button refreshes the display.

NOTEFIELD TEMPLATE (CONFIGURATION)

No problems to announce.

CARD HOLDER TAB LAYOUT

No problems to announce.

CONFIGURE BADGE PRINTER

No problems to announce.

BADGE LAYOUT UTILITY

No problems to announce.

COMMAND FILE (DATABASE)

If a command file is sent when the Database Server is not on line, the User Interface will
shutdown.


